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1 Update Records
Document version Release time Update record

V2.0 September 1th, 2025 First release of document

2 Applicable Model
The product models applicable to this article are as follows:

MC-C2KXS、MC-C2KXM、MC-C2KXE、MC-C2KXL、MC-C2KX、MC-C2K、MC-C2X



MC-C2 Multimedia Server Broadcast Control Software User Manual

5en.mooncell.com.cn

3 Product Overview
3.1 Operation Interface

Launch the software and enter the startup page:

Within the scene templates, you can select different templates to create projects. You can view a list of recently

opened projects and open them. Below, you can switch languages, configure the interface, and edit preferences.

Access the software interface by creating a new program/opening a program, or by clicking on templates/projects.
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Click the floating button to enable window floating. Click it again to disable the floating state. The floating

button makes the window easier to manipulate. Users can configure it according to personal preference.
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You can set the window to float. Clicking the button again will cancel the floating state. The floating button makes

the window easier to manipulate. Users can configure this according to their personal preferences.

Users can also freely drag and drop individual windows to other locations for layout arrangement based on their

personal preferences.

Software Operation Interface：
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3.2Menu Bar

3.2.1 File

(1) New Project: Select the project storage path and project name to create a new project.

(2) Open Project: Open an existing project.

(3) Recently Opened Projects: Quickly access recently opened projects.

(4) Save Project: Quickly save the current project.

(5) Backup Project: Save a backup of the current project to a user-selected path.

(6) Save As and Open Project: Save the current project to a user-selected path and open the project in the new

location.

(7) Save Snapshot: Save a snapshot backup of the project.

(8) Snapshot Management: Manage automatically or manually saved snapshot projects.

(9) Package Project: Consolidate all used resources, including all assets from Program Management, into a single

folder. This facilitates backup and sharing. Opening the project file within this package on another device will not

result in missing assets.
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Export Program List: Quickly select and export the program list based on the edited program name and content for
easy viewing.

Authorization Management: Manage authorization.

Settings: Open the settings menu to configure various basic functions and properties for the project and software.



MC-C2 Multimedia Server Broadcast Control Software User Manual

10en.mooncell.com.cn

Automation: Configure startup scripts for power-on/off operations to automatically run projects upon system boot.



MC-C2 Multimedia Server Broadcast Control Software User Manual

11en.mooncell.com.cn

Save as Scene Template: Save the current project as a template, which will appear on the startup page.

Exit: Exit the server broadcast control software.

3.2.2 Edit

The Edit menu bar includes Undo, Redo, Copy, and Paste. After selecting Align, when arranging windows and

screen materials on the stage, alignment and snap effects will appear to align them. As shown in the figure:
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3.2.3 Online

(1) Set as Standby: Switch between primary and standby servers.

(2) Primary/Standby Management: Configure backup relationships, including integrated or independent backups,

and add control server settings to establish corresponding relationships.
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(1) Synchronize Screen Configuration: Synchronize screen settings.

(2) Add Standby Server: Select a server to add as a standby server.

(3) Connect to Standby Server: View connected standby servers and establish connections.

(4) Disable Master-Slave Control: Deactivate master-slave server control.

(5) Remove Standby Server: Delete a standby server.

(6) Master-Slave Management: Add and configure master-slave servers to enable a single server to control the

playback rhythm of corresponding software across multiple servers.

Master-Slave Security Settings: In master-slave security mode, open the security settings pop-up window, set a

password, and check the box to enable password protection.
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Server Management: Manage connected servers by performing operations such as power cycling, software updates,

and configuration settings.

3.2.4 Stage
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(1) Add Display: Click Add Screen →Add Locally Connected. The following dialog box will appear. It displays

information such as the resolution and refresh rate of the locally connected screen. Users can make selections based

on the displayed information:

(1) Zoom: Select different zoom ratios in Stage - Zoom, or scroll the mouse wheel within the stage to zoom in or

out.

(2) Edit Mode: Switch the editing state between All Mode, Screen Mode, and Program Mode.

(3) Standby: Click Standby to display the standby layer or a black screen. In this state, the program will continue

playing without stopping.

(4) Connect: Connect refers to linking to display devices. Once connected, edited content will project onto the

display, provided connected screens are added in the software and all displays are enabled. Click the Connect

button in the top-right corner of the Stage to connect or disconnect.

(5) Distribute Media: Clicking Distribute Media updates media to the corresponding network display server.

(6) Distribute Media During Connection: Checking this option automatically updates media to the network display

server each time you click Connect.

(7) Transfer Only Necessary Media: When using primary/backup server software configurations, selecting Transfer

Only Necessary Media prevents media not placed on the program page in the primary software's media library from

syncing to the backup software. Deselecting this option syncs all media to the backup software.

(8) Open All Screens: Clicking Open All Screens activates channel screens and displays the preset image from the

large screen display software.
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(1) Close All Screens: Click to close all screens, switching to the desktop view.

(2) Live Preview: Enables real-time playback and preview of the stage.

(3) Thumbnails: Uses low-resolution thumbnails for media preview, improving editing efficiency when playing

multiple large video clips simultaneously during a presentation.

(4) Wireframe: Display all images and videos as rectangular wireframes showing media names and durations.

Wireframe mode, like thumbnails, saves memory and boosts editing efficiency.

(5) VNC Control: Enable remote control by adding VNC functionality.

(6) Background Color: Choose from various background colors to suit personal preferences.
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3.2.5 Media

You can click the Media Library to add videos/audio/images, text, PPTs, capture card devices, NDI network

screens, timers, webpages, or folders to the Resource Management - Media Library.

(1) Add Video/Audio/Images: Using this command, media files can be added to the media library from disk or

media folders. The media library displays information such as asset name, asset type, thumbnail, resolution, and

duration.
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(1) Adding PPT: When adding PPT files, you can choose between two different modes: Animation Mode and

Image Mode. Set the resolution as needed. For Animation Mode, it is recommended that the computer running the

C2 software has a genuine copy of Office 2016 (64-bit) or a later version installed (Office 365 is not supported).

Ensure the software is activated and capable of opening and playing the PPT files normally.

You can set the resolution and playback mode for PowerPoint presentations:
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After setup is complete, the added PPT will appear in the media resources window:

You can add PPT materials to the program window for editing. During playback, you can use the arrow keys on

your keyboard to navigate slides, functioning identically to standard PPT navigation.

As shown in the figure below, when the PPT button is active (green), PPT page-turning applies globally. Regardless

of which window is currently selected in the software, the arrow keys function for PPT page-turning. When the

PPT button is inactive (black), the arrow keys revert to switching between programs in the program manager when

playing other programs that do not contain PPT files.
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(1) Add Capture Card: This command enables the addition of capture cards to achieve real-time video capture from

on-site sources. C2 supports simultaneous capture from multiple cards and allows adjustment of captured video

streams. Capture cards default to independent playback mode, which cannot be altered. In this state, you may

customize the display format of captured images. Added capture cards can be directly used as source material by

adding them to the Program Management window.

(1) Add Folder: Click Add to create a folder. You can add or remove assets by dragging them into or out of the

folder. You may either drag local assets directly into the media library organized by folders, or first select a folder

and then drag media assets from your local files into that folder.
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(1) Add More (Subtitles): Use this command to add text to your media, then adjust it like any other media element.

You can modify the font style, size, color, subtitle background color, scrolling method, and more for the input text.

Edit the text directly within the text box or paste the desired text into it. The software will generate scrolling

subtitles based on your settings. After unlocking the fixed scrolling area, you can adjust the scrolling speed, width,

and height of the subtitles.
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(1) Add More (NDI): Ensure the source computer and capture computer are on the same local area network. Use

this command to add NDI network screens. NDI employs digital high-definition Ethernet transmission technology,

achieving transmission quality equivalent to SDI. Compared to coaxial cable transmission, NDI offers greater

stability and stronger interference resistance. It also enables real-time, bidirectional audio and control signal

transmission alongside video signals. Added NDI network screens can be directly used as source material by adding

them to the program management window.

After selecting to add an NDI device, a pop-up window appears (as shown below):
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Add the corresponding NDI device based on the IP address of the source computer. Click OK to use the added NDI

device as a media source.

(1) Add More (Timers): Click “Add More,” select “Add Timer,” and after selecting it, you can configure

parameters such as name, duration, time type, counting status, and stop action. You can also set color and

transparency. After completing the settings, click “Confirm” to add the timer to the asset library.
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Timers can also be added as elements to the program schedule.

(1) Add More (Clock): Click “Add More,” select “Add Clock,” and configure the text background color and
transparency.

(1) Add More (Network Stream): Click Add More, select Add Network Stream, edit the name, and enter the

network stream address.

(1) Add More (Spout): Click “Add More,” select “Add Spout,” and connect to interactive content with Spout

interfaces.

This enables local transmission and playback of interactive content via the Spout protocol, eliminating capture card

latency and channel limitations.
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(1) Add More (Webpage): Click Add More, select Add Webpage, enter the webpage URL. You can adjust display

resolution and fill mode settings.

(2) Add More (Program): Click Add More, select Add Program, drag it to the playback window and click Play to

run the program directly.

(3) Add More (Desktop): Click Add More, select Add Desktop, choose the desktop screen to add. You can drag it

directly to the playback window and click Play to display the desktop.
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(1) Add More (Media Collection): Click “Add More,” select a media collection, drag and drop media files into the

same folder, and add the entire folder to the media library. This streamlines media management, making the

workflow more organized and efficient.

(1) Add More (Solid Color Assets): Click “Add More,” select solid color assets, freely set the color, with an initial

resolution of 1920×1080. Place them in the program and adjust the resolution and size as needed.
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(1) Transcoding: If videos experience playback stuttering, you can select the corresponding video in the media

library to perform transcoding optimization.

(1) One-Click Optimization: Select One-Click Optimization to choose materials added to the media library and

perform one-click transcoding optimization for images.
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(1) Image Optimization: Select Image Optimization to enable one-click transcoding and optimization for images.
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3.2.6 Program

Select any program to perform actions such as stopping playback, playing the next program, adding programs

(insert before/insert after), adding window layers (insert above/insert below), or deleting programs. Select any

program node or program layer, right-click, and choose “Delete” from the context menu.
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3.2.7 Control

The Control Menu primarily configures ccMAX, input/output control, and protocol viewing.

3.2.8 Tool

The Tools menu primarily allows configuration of screen display performance, input monitoring, EDID

lock/unlock, user management, and more.
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3.2.9 View

The View menu primarily controls window display and layout adjustments. Simply check the boxes for the

windows you wish to display. You can also configure your preferred window layout and “Save Window Layout” to

restore it upon program restart. If windows become disorganized and you cannot locate a specific one, click Reset

Layout to revert to the default configuration. To enable network update status display, check the Network Update

Status box within the window. A corresponding panel will then appear on the right side of the software interface.
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3.2.10 Help

Help primarily allows you to view software version information, dongle information, shortcut key information,

integrated graphics driver usage instructions, and warning logs.

3.3 Tool Bar

The software's toolbar provides convenient access for users. It includes:

(1) File Tools: New Project, Open Project, Save Project, Package Project.

(2) Quick Tools: Copy, Paste, Undo, Redo.

(3) Window Tools: Save window layout, load window layout, manage window layouts.

(4) Program Management Tools: Global Brightness, Global Contrast, Global Volume, Screen Lock,
Primary/Backup Switching, Mapping Layout, Server Management, Video Frame Capture.
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3.4 Asset Library

Click the Add button in the lower-left corner of the resource management interface or right-click in the blank area

of the media library to add media assets. The method is identical to the Media Resources menu. Alternatively, you

can drag media assets directly into the media library. Right-click an asset to continue adding assets or rearrange

their order. You can locate the resource's position and edit it.
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3.5 Program Page List

The program list displays all created programs in a grid layout. Users can perform playback operations on all

programs within the floating window of the program list.

After clicking on a program, all of its properties will be displayed on the right side of the program management
interface.
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Click the + icon in the bottom-left corner, or right-click in the blank area, to add a program page or program page
group.

3.6 Planned Tasks

You can schedule program playback, output management, and other tasks for specific future times, enabling

weekly fixed cycles or fixed-time switching of program content.
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3.7 Program Management
In program management, you can add programs and windows to schedule programming.

3.7.1 Add or Remove Programs

In the upper-right corner of the program management interface, you can quickly add a program by clicking

the button. Select a program, right-click, and you can copy, paste, or delete it.
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Select a program to edit its properties in the Program Properties panel. You can also add/insert or delete layers here.

Keyboard Triggering: Assign any of the 36 keys on the keyboard—including all 26 English letters and the numerals

0-9—as shortcut keys to bind to specific programs (each key can only be bound to one program). Use these keys to

trigger program playback.

Trigger Control: Add input controls for standard inputs, MIDI controllers, DMX512, and sensor inputs. Each added

input control must have a unique name and channel. In the Trigger section, define trigger conditions and bind them

to programs to initiate playback.
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3.7.2 ProgramWindow Layer

(1) Add Window: Right-click any program window to insert or delete a program layer. Alternatively, click the

shortcut buttons below Program Management to add a window/program tab layer.

Press the Ctrl key and click the left mouse button to select multiple program layers. You can edit the batch program

layer properties in the right-hand Properties pane:
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In program management, select multiple program layers to move them up or down in bulk or delete them. On the

stage, drag multiple windows to move them as a group:
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(1) Program Window Properties: Select the window you wish to modify within the program management panel.

This will open the window properties panel on the right, where you can adjust the window's name, display color,

position, size, rotation angle, and other attributes.
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You can also click the shortcut button on the window layer to configure settings such as window color, sound

output, visibility, and whether to lock the window.

Window layers also have a hierarchical relationship similar to regular layers, with layers positioned higher in the

stack having higher priority.

(1) Program nodes in the window layer: Program nodes can be copied using the shortcut Ctrl+C and pasted using

Ctrl+V. Alternatively, press Alt+Left Click to select a program node and drag it to the desired paste location for

quick copying. Right-click a selected program node to view its resource location and folder, set playback mode, or

copy its chroma key, overlay, and effect properties to paste onto other program nodes.
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By selecting “Go to Next Program” or “Go to Other Programs,” you can achieve program-jumping functionality to

automatically switch between programs.

Program jump effects can also be configured in the program node properties.
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3.7.3 Process Label Layer

Label functionality is used to mark each program name, performance sequence, or time point. Multiple layers of

process labels can be added to mark different content or notes.

3.7.4 Program Node Attributes

After selecting a program node, you can configure detailed settings for each property in the program node

properties panel on the right:
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(1) Basics: Here, you can edit the playback duration of assets, as well as their start and end times. In blending

modes, there are two options: Overlay and Multiply. In Overlay mode, the top layer covers the bottom layer. In

Multiply mode, the effect of two layers is multiplied.
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Program name and resource duration cannot be modified:

Setting the playback duration allows you to extract a segment from the media for playback. The start time

determines when the program begins within the media resource, while the end time specifies when playback

concludes within the resource:

Keyboard triggers can be bound to keyboard shortcuts to control playback and stop of program nodes. The console

supports MIDI, test input, and DMX512:

MIDI Play/Stop Color: Configure the color of the MIDI console button when the program is playing or stopped:
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Trigger the end action to set the action performed when the trigger is activated, without affecting keyboard trigger

functionality:

Playback Mode: Set the action when a program segment finishes playing. When selecting to jump to another

program, you must choose the destination:

The fill mode determines how media assets fill the window. Full-screen mode maximizes screen coverage without

preserving the original aspect ratio of the asset:
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Proportional fill will fill the window while preserving the original proportions of the material:

Blending Modes: There are two blending modes: Overlay and Add. In Overlay mode, the top layer covers the

bottom layer. In Add mode, the effect of overlaying two layers is achieved.

Coverage Mode:
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Additive Mode:

(1) Effect Editing: Adjust playback speed, volume, saturation, hue, contrast, brightness, feathering, and other

effects. When modifying media volume, ensure playback speed is set to 1; otherwise, no audio will be output.
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Cropping: When the Stretch option is selected, cropping will stretch the footage in one or multiple directions while

preserving the original frame, altering the footage's original aspect ratio:

When cropping is selected, the cropping operation will trim portions of the frame while maintaining the original

aspect ratio of the source material:
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Original material:

When the media color is set to red:

(1) Covering Template: Multiple templates available for selection, or users may define their own. Use the arrow

keys to move vertex coordinates.
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(1) Chroma Key: Multiple templates available, or users can define their own. Use arrow keys to move vertex

coordinates. Without chroma key:

Use chroma keying to remove the green background:
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3.8 Stage

3.8.1 Add Screen

Click the Add Screen option in the upper-left corner of the Stage window to choose between adding a local display

screen or a custom screen:

Screen Properties: Click to select a screen already added to the stage window. In the right-hand properties panel,

you can configure the screen's properties.
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3.8.2 Display Management

Click the “Display Management” button in the upper-left corner of the stage to open the Display Management

window. This new window is used to edit the correspondence between surfaces and actual outputs.
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(1) Top Toolbar:① Add Screen;② Exit Drawing Mode and Restore Mouse;③ Add Rectangular Surface;④ Add
Polygonal Surface;⑤ Display Recognition;⑥ Output Display Surface Borders.

(2) Surface List: Displays all surfaces in the list and allows surface operations.

(3) Screen List: Displays all added outputs by IP and allows screen operations.

(4) Output Area: Region for adding actual outputs and defining surface-to-screen mapping relationships.

(5) Stage Area: Aligns with the actual stage to determine surface positioning and scaling based on real outputs,
recreating the authentic stage environment.

(6) Top Properties Bar: Displays selected surface or screen attributes—position, size, rotation, box dimensions,
etc.—for convenient reference during debugging.

3.8.3 Open Screen

Click the “Open Screen” button in the upper-left corner of the stage to open the channel screen, displaying the
preset image from the large-screen display software.
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3.8.4 Connection

Connecting refers to projecting edited footage onto display devices, provided that all added display screens have

been arranged and activated within the software. Click the Connect option in the upper-right corner of the stage to

establish or disconnect connections. While in connected mode, screens within the stage interface cannot be moved.

3.8.5 Standby Mode

In standby mode, the window will go black and cannot output video or audio, but this does not affect the playback

of the current program. Video assets in the standby layer will not be displayed on the output device during normal

playback. Only when switched to active mode will assets on the standby layer play on the output device. Use the

standby button in the top-right corner to toggle between standby and active modes, or use the shortcut key Ctrl+B

to switch.
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3.8.6 Hardware Performance Monitoring

Hardware performance monitoring tracks the usage status of all server hardware components at any given time. If

the software experiences significant video playback stuttering during operation, first check the monitored CPU and

memory usage rates. High CPU and memory utilization can cause video playback stuttering, necessitating

transcoding optimization of the video assets; alternatively, switch the software's preview mode to thumbnail or

wireframe mode.
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3.8.7 Properties

In the Properties interface, program nodes, programs, and window properties are displayed. Users can edit these

properties in the Properties window.

3.8.8 Playback Status

The playback status interface displays the playback status of all editing windows. You can control playback using

the playback buttons on the right. Dragging the playback progress bar in the window allows you to fast-forward

through the footage.
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3.8.9 Network Update Status

The network update status indicates the transmission and update progress when the control server transfers all

edited and used assets to each display server or standby server in online mode or primary-standby mode.
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3.8.10 Lock

Click the lock button on the toolbar to lock the software interface.

3.9 Timecode Solution List
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3.9.1 Introduction

The Timecode Scheme List enables the configuration of timecode control plans for multiple distinct program

segments, supporting simultaneous synchronization and triggering of timecodes across different time intervals

within multiple source materials.

3.9.2 Add Timecode Scheme

Click “View > Timecode Scheme List” to open the settings window, which is located by default on the right side of
the software's main interface.

Click the shortcut key in the lower-left corner of the window to add or remove schemes.
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3.9.3 Edit Timecode Scheme List

Click the arrow on the right to expand the detailed panel for the schedule.

Check the Monitor option to view timecode information; check the Control option to receive timecode control.

In the Device dropdown menu, select either LTC or MTC timecode.

In the Mode dropdown menu, choose between Trigger Mode or Sync Mode for timecode. In Trigger Mode,

receiving timecode triggers actions like media playback. In Sync Mode, media playback automatically

synchronizes with timecode upon reception.

In Timecode Offset, set the offset value to adjust timecode delay.
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3.9.4 Timecode Scheme Management

Click the button in the lower-left corner of the management window to add objects that receive timecode.

After adding the timestamp reception object, click the lock button to the right of “Scheme 1” to lock the label layer.
Once locked, labels within the layer cannot be edited, preventing accidental changes.

After the content associated with a timecode label is deleted, the label becomes invalid. The text turns red and
displays the message “No control object.”

3.9.5 Enable Timecode Control

When timecode reception is required, simply check the “Control” box. All content within the schedule and the

designated time periods for each item will receive timecode control.
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3.10 LTC Generator

3.10.1 Introduction

The LTC generator can be used to generate and transmit LTC timecode, supporting LTC loop-through

functionality.
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3.10.2 Add LTC Generator

The LTC generator can be used to generate and transmit LTC timecode, supporting LTC loop-through
functionality.
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3.10.3 Send LTC timecode

Check “Loop Input” to enable C2 software to receive its own generated timecode. When “Control” is selected in
the timecode reception scheme, all planned clips will receive LTC control signals sent by the software itself.
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Check “Sound Card Output,” and the C2 software will send LTC timecode externally through the server sound
card's audio output (speaker) interface.

Select the output channel by checking the box, and choose the frame rate from the dropdown menu.
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After clicking Start, LTC timecode generation and transmission will begin. You may pause or stop transmission at
any time. Clicking Reset will reset the timecode start time to zero.
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4.Quick Start Guide
4.1 Software Window Layout Adjustment

The layout of the software interface can be freely adjusted according to personal preference. You can resize and
reposition windows such as Program Management, Playback Status, Main Program, and Resource Management.
After making adjustments, save them as the default layout to preserve the customized configuration. Once added,
display boxes can be moved and arranged as desired.

4.2 Screen Casting of Media Content
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4.2.1Add and Arrange Screens

Add a screen as shown in the figure. In the pop-up window, select the connected display screen. After selection,
click OK to add it. Once added, you can adjust the size of the display window and arrange its position.

4.2.2 Add Media Content

Right-click in the media library or select Add Assets in the bottom-left corner.
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In the pop-up window, select Add Assets, then click Open to add them to the asset library.

4.2.3 Add andArrange ProgramWindows
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4.2.4Set Window Basic Properties

Select the window and adjust settings in the Program Window Properties panel at the top-right corner:

4.2.5Edit Media Content

Add the media content to the prearranged window for display.
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4.2.6 Output Image

After completing all operations—adding screens, arranging windows, adding assets, and editing assets—project the
edited asset effects onto the display device. First, open the screen:

The display device now shows a grid diagram:

Execute the connection to project the edited material effects onto the large screen.

4.3 Window Playback Mode

4.3.1Window Function Description

Customize window resolutions and freely arrange windows on display devices. Add playable content to

corresponding windows within the program and set the playback sequence. Based on program requirements,

conveniently add content to the designated window positions for each program, eliminating repetitive content

operations.
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4.3.2Add/Delete Windows

Click the shortcut button, or right-click the program management interface and select Insert Window Layer to add a

window. Each window has a default color that can be customized. Select the layer corresponding to the window

you wish to delete, right-click that layer and choose Delete Layer, or click the shortcut delete button (you can also

use the Delete shortcut key) and then click Confirm to delete the window.

4.4 Window Operation Instructions
Create a window and change its resolution: Select the window whose resolution you wish to modify, then adjust the

resolution in the properties panel at the bottom right (this also sets the window's resolution on the display device).

Arrange all added windows on the display device as needed.

Add media to the corresponding windows in the program according to playback requirements, and configure the

program's playback order and properties.
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After selecting a clip in Program Management, configure its effects in the Properties panel at the bottom right: crop,

transparency, volume, hue, saturation, etc. In Playback Mode, you can also set actions after the clip finishes playing:

loop playback, stop playback, freeze on the last frame, play the next program, or jump to another program. You can

also trim the clip by setting start and end times.

When a clip is in playback state, its background color turns green:

Set window properties: Configure preview, audio output, default window color, rotation, and more.
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4.5 Program Jump

C2 enables the action of jumping to any other program after the current program finishes playing. To accomplish
this, two settings are required:

Select which video's end time within the program will serve as the jump trigger. As shown below, configure the
system to jump to Program 4 after Program 1 finishes playing.
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Select the clip, then in the Program Node Properties panel at the top right, first change the clip's playback mode to
“Go to Another Program.” Next, select “Program 4” from the dropdown menu below.
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